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GroupWise 7

August 15, 2005 

Updated October 5, 2007, with upgrade instructions for Open Enterprise Server 2 and SUSE® Linux 
Enterprise Server 10.

1  Product Overview
Novell® GroupWise® 7 provides substantial improvements over GroupWise 6.x in six areas:

Windows Client Enhancements:  The Windows* client has a new look and feel that includes 
the Navigation Bar, Panels, Home Folder, color schemes, and new icons. In addition to the new 
look and feel, you can now create and view multiple calendars, create all day events, spell 
check as you type, perform Quick Filters, see the Messenger presence information for users, 
create HTML signatures, and control inline quotations.
Cross-Platform Client Enhancements:  The Cross-Platform client has added many features 
including spell checking, rules, junk mail handling, cleanup tools for your mailbox, backup and 
restore, and the ability to set your default views, create all day events, and control inline 
quotations. 
WebAccess Client Enhancements:  The WebAccess client has a new look and feel that brings 
it closer to the look and feel of the Windows client. Some of the new features include the ability 
to drag and drop items, right-click items to display menus, easier tabbed navigation, and name 
completion from your Frequent Contacts address book.
Administration Enhancements: GroupWise administrators have additional control over 
users' working environments, including granting rights to users to edit distribution lists, 
appending global signatures to users' messages, and controlling the appearance of the 
GroupWise Windows client interface.
Agent Enhancements:  The POA now supports SOAP, so that SOAP clients such as 
EvolutionTM can connect to GroupWise. The Internet Agent can fail over to an alternate Internet 
Agent to provide redundancy for outbound Internet mail. The GroupWise Linux* agents can 
now run as a non-root user and the new High Availability service automatically restarts the 
Linux agents if they go down unexpectedly. The Linux and Windows agents support IPV6.
GroupWise Connector for Outlook:  The GroupWise Connector for Outlook* allows you to 
use Microsoft* Outlook to connect to your GroupWise System. The GroupWise Connector for 
Outlook includes support for e-mail, meeting requests and appointments, recurring 
appointments, scheduling, tasks, contacts, shared folders, delegates, and proxy. 

For a complete list of new features in GroupWise 7, see What's New in Update in the GroupWise 7 
Installation Guide (http://www.novell.com/documentation/gw7).

2  NetWare/Windows: GroupWise System 
Installation Instructions
To install GroupWise 7 on NetWare® or Windows:

1 Run setup.exe at the root of the GroupWise 7 Administrator (NetWare/Windows) CD.
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The GroupWise Installation program lets you view the Readme, the Quick Start, and the 
Installation Guide before you start installing GroupWise.

2 Click Create or Update a GroupWise System.
3 Follow the on-screen instructions.

For detailed system requirements, installation and update instructions, and a complete list of new 
features, see the GroupWise 7 Installation Guide (GroupWiseInstallationGuide.pdf) in the \docs\us 
directory on the GroupWise 7 Administrator (NetWare/Windows) CD or on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).

3  Linux: GroupWise System Installation 
Instructions

1 For ease of installation, make sure that ConsoleOne® is installed on the Linux server where you 
want to create your GroupWise system.

ConsoleOne is located in /usr/ConsoleOne/bin.

If necessary, you can download ConsoleOne from the Novell Downloads Web site (http://
download.novell.com).

2 At the server where you want to create your GroupWise system, open a new terminal window, 
then become root by entering sux and the root password.
When creating your GroupWise system, you must run the GroupWise Installation program in 
an environment where The X Window System* is running.

3 Change to the root of the GroupWise 7 Administrator (Linux) CD.
4 Start the GroupWise Installation program:
./install

5 Click Create or Update a GroupWise System.
6 Follow the on-screen instructions.

For detailed system requirements, installation and update instructions, and a complete list of new 
features, see the GroupWise 7 Installation Guide (GroupWiseInstallationGuide.pdf) in the \docs\us 
directory on the GroupWise 7 Administrator (NetWare/Windows) CD of the GroupWise 7 
Documentation Web site GroupWise 7 Documentation Web site (http://www.novell.com/
documentation/gw7).

3.1  Linux: Operating System Update
If you are updating your version of Linux as well as updating GroupWise, perform the Linux 
operating system upgrade first. In addition, when you upgrade on a server where GroupWise 
WebAccess or Monitor is installed, you need to run a script that reconfigures the WebAccess 
Application or the Monitor Application for the new Apache and Tomcat configuration and directory 
structure.

“Open Enterprise Server 1 to Open Enterprise Server 2” on page 3
“SUSE Linux Enterprise Server 9 to SUSE Linux Enterprise Server 10” on page 5
“Updating the WebAccess Application and the Monitor Application after the Operating System 
Upgrade” on page 6
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3.1.1  Open Enterprise Server 1 to Open Enterprise Server 2

When you upgrade from Open Enterprise Server (OES) 1 to OES 2 with GroupWise installed on 
your OES server, you encounter package conflicts that must be resolved. A pop-up message appears 
immediately before the Installation Settings screen that informs you that the Delete Unmaintained 
Packages option is selected under Update Options. OES 2 considers GroupWise an “unmaintained 
package.” This means that, by default, your GroupWise software will be deleted as part of the 
upgrade process, unless you follow the instructions below.

1 Read the pop-up warning carefully, then click OK to close the pop-up.

The pop-up describes three possible actions you can take to resolve the GroupWise status as an 
unmaintained package. This procedure steps you through the second of the three possible 
actions. This alternative works most efficiently for preserving your GroupWise installation.

2 When ConsoleOne® is installed on the server:
The following message displays below the Packages link on the Installation Settings screen:
Cannot solve all conflicts. Manual intervention is required.

2a Click the Packages link.
The upgrade process checks for package conflicts, then displays the following message:
NOVLc1-1.3.6-1.i386 is locked and cannot be uninstalled.

2b Select Keep NOVLc1, then click OK - Try Again.
The upgrade process checks again for conflicts for NOVLc1 and displays one or more 
package-related warnings, providing you with alternatives for how to handle each conflict. 
The specific warnings you receive depend on the packages installed on the server you are 
upgrading. Therefore, warnings vary. Here are some examples:

NOVLc1-1.3.6-1.i386 cannot be installed due to missing 
dependencies.

novell-eguide-2.1.32.noarch cannot be installed due to 
missing dependencies.

The messages fall into two categories of problems:
Missing dependencies for ConsoleOne (the NOVLc1 package)
Missing dependencies for some other product package besides ConsoleOne (for 
example, eGuide)

The following steps help you decide which action to take for each type of message.
2c If the message indicates missing dependencies for ConsoleOne (NOVLc1), select Ignore 

This Requirement Just Here.
2d If the message indicates missing dependencies for some other product package besides 

ConsoleOne, and you are sure that you do not want that product package, select Delete 
package_name.

WARNING: ConsoleOne is dependent on a variety of packages. Delete packages only 
when you are certain that they are not required by ConsoleOne. If in doubt, select Keep 
package_name.

2e When you have selected an action for each conflict message, click OK - Try Again.
GroupWise 7 3
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The upgrade process checks again for conflicts for NOVLc1. Additional messages might 
be displayed for you to select actions to resolve the conflicts. This cycle repeats until all 
conflicts have been resolved, then you successfully reach the Packages page.

3 On the Packages page, select Search in the Filter field.
4 Search for the GroupWise packages that are installed on the server by typing the following in 

the Search field:
novell-groupwise

5 Click Search.
Depending on what GroupWise components are installed on the server, the search results 
include some of the following packages:
novell-groupwise-admin
novell-groupwise-agents
novell-groupwise-dbcopy
novell-groupwise-gwcheck
novell-groupwise-gwha
novell-groupwise-gwia
novell-groupwise-gwinter
novell-groupwise-gwmon
novell-groupwise-monitor
novell-groupwise-webaccess

6 Right-click the first GroupWise package in the list, then click All in This List > Keep.
This changes the status of each GroupWise package from Delete to Keep.

7 Search for the NOVLc1 package.
The NOVLc1 and NOVLc1Linuxjre packages should be listed and marked as locked. This 
means that they will not be deleted.

8 If these packages are marked with a Delete status, change their status to Keep.
9 Click Accept on the Packages page.

10 If you are presented with a font License Agreement, click Accept.
11 Click Continue to return to the Install Settings page.
12 Verify that the package conflict message is now gone from under the Packages link, then 

continue with the upgrade process.
13 After you have finished the upgrade, reinstall the NDSbase RPM that was originally installed 

with ConsoleOne.
The upgrade process removed it, but it is still needed by ConsoleOne.
13a In a Linux terminal window, log in as root, then change to the directory where you 

originally extracted the ConsoleOne files.
13b Change to the Linux subdirectory.
13c Use the following command to reinstall the NDSbase RPM:

rpm -ivh NDSbase-8.7.3.7-38.i386.rpm

If you encounter problems with GroupWise after you have upgraded from OES 1 to OES 2, see TID 
3570778 in the Novell Knowledgebase  (http://www.novell.com/support/supportcentral) for 
assistance.
7
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3.1.2  SUSE Linux Enterprise Server 9 to SUSE Linux Enterprise Server 10

When you upgrade from SLES 9 to SLES 10 with GroupWise installed on your SLES server, you 
encounter package conflicts that must be resolved.

1 When ConsoleOne is installed on the server:

The following message displays below the Packages link on the Installation Settings screen:
Cannot solve all conflicts. Manual intervention is required.

1a Click the Packages link.
The upgrade process checks for package conflicts, then displays the following message:
NOVLc1-1.3.6-1.i386 is locked and cannot be uninstalled.

1b Select Keep NOVLc1, then click OK - Try Again.
The upgrade process checks again for conflicts for NOVLc1 and displays one or more 
package-related warnings, providing you with alternatives for how to handle each conflict. 
The specific warnings you receive depend on the packages installed on the server you are 
upgrading. Therefore, warnings vary. Here are some examples:

NOVLpkia-2.7.0-6.i386 is locked and cannot be 
uninstalled.

NOVLc1-1.3.6-1.i386 cannot be installed due to missing 
dependencies.

The messages fall into two categories of problems:
A locked package
Missing dependencies for ConsoleOne (the NOVLc1 package)

The following steps help you decide which action to take for each type of message.
1c If the message indicates a locked package, select Keep package_name.
1d If the message indicates missing dependencies for ConsoleOne (NOVLc1), select Ignore 

This Requirement Just Here.
1e When you have selected an action for each conflict message, click OK - Try Again.

The upgrade process checks again for conflicts for NOVLc1. Additional messages are 
displayed for you to select actions to resolve the conflicts. This cycle repeats until all 
conflicts have been resolved (approximately nine times), then you successfully reach the 
Packages page.

2 On the Packages page, select Search in the Filter field.
3 Search for the GroupWise packages that are installed on the server by typing the following in 

the Search field:
novell-groupwise

4 Click Search.
Depending on what GroupWise components are installed on the server, the search results 
include some of the following packages:
novell-groupwise-admin
novell-groupwise-agents
novell-groupwise-dbcopy
novell-groupwise-gwcheck
novell-groupwise-gwha
novell-groupwise-gwia
GroupWise 7 5
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novell-groupwise-gwinter
novell-groupwise-gwmon
novell-groupwise-monitor
novell-groupwise-webaccess

5 Right-click the first GroupWise package in the list, then click All in This List > Keep.
This changes the status of each GroupWise package from Delete to Keep.

6 Search for the NOVLc1 package.
The NOVLc1 and NOVLc1Linuxjre packages should be listed and marked as locked. This 
means that they will not be deleted.

7 If these packages are marked with a Delete status, change their status to Keep.
8 Click Accept on the Packages page.
9 If you are presented with a font License Agreement, click Accept.

10 Click Continue to return to the Install Settings page.
11 Verify that the package conflict message is now gone from under the Packages link, then 

continue with the upgrade process.
12 After you have finished the upgrade, reinstall the NICI RPM and the NDSbase RPM that were 

originally installed with ConsoleOne.
The upgrade process removed them, but they are still needed by ConsoleOne.
12a In a Linux terminal window, log in as root, then change to the directory where you 

originally extracted the ConsoleOne files.
12b Change to the Linux subdirectory.
12c Use the following commands to reinstall the RPMs:

rpm -ivh nici-version-i386
rpm -ivh NDSbase-version.i386.rpm

If you encounter problems with GroupWise after you have upgraded from SLES 9 to SLES 10, see 
TID 3570778 in the Novell Knowledgebase  (http://www.novell.com/support/supportcentral) for 
assistance.

3.1.3  Updating the WebAccess Application and the Monitor Application after the 
Operating System Upgrade

When you upgrade your Linux operating system, OES 2 installs new versions of Apache and 
Tomcat by default. SLES does not; you must install them manually by following the procedure in 
this section. In addition, the GroupWise 7 installations of the WebAccess Application and the 
Monitor Application must be modified to accommodate changes made in Apache and Tomcat. The 
WebAccess/Monitor Update script takes care of this process for you. This script is available with 
TID 3624780 in the Support Knowledgebase (http://www.novell.com/support/supportcentral).

1 If you have upgraded to SLES 10, use YaST to install Apache and Tomcat if they were not 
already installed on SLES 9:
1a Start YaST, then provide the root password.
1b Click Software Management.
1c In the Search field, type Apache, click Search, then select apache2 from the list.
1d In the Search field, type Tomcat, click Search, then select tomcat5 from the list.
7
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Apache 2 was part of your SLES 9 installation, so it should have been automatically 
upgraded. Tomcat changed from Tomcat 4 to Tomcat 5, so unless Tomcat 5 was installed 
on SLES 9, Tomcat 5 needs to be installed.

1e Click Accept.
1f Follow the prompts to install the needed packages to your SLES 10 server.

1g Exit YaST.
2 Download the WebAccess/Monitor Update script from TID 3624780 in the Novell Support 

Knowledgebase (http://www.novell.com/support/supportcentral) to a convenient location on 
your Linux server.

3 Change to the directory where you downloaded the script file.
4 Give the script file execute permissions:
chmod +x fixgwweb.sh

5 Run the script.
The script makes some slight reconfigurations of GroupWise files and directories that were 
originally set up when the WebAccess Application and the Monitor Application were installed 
on your previous version of Linux.

Apache 2: On OES 1 and SLES 9, Apache 2 used the mod_jk connector to facilitate 
communication between Apache and Tomcat. On OES 2 and SLES 10, Apache 2 uses the 
mod_proxy module instead. The WebAccess/Monitor Update script modifies the 
gw.conf file with this change. On SLES 10, the script also creates a symbolic link from 
/etc/opt/novell/gw/gw.conf to the new Apache 2 location of /etc/
apache2/conf.d/gw.conf.
Tomcat 5: On OES 1 and SLES 9, the WebAccess /var/opt/novell/gw directory 
was linked to /var/opt/novell/tomcat4/webapps/gw. The script changes this 
link to /var/opt/novell/tomcat5/webapps/gw. For Monitor, the /var/opt/
novell/gwmon directory now links to/var/opt/novell/tomcat5/webapps/
gwmon.

6 Start or restart Tomcat.

7 Start or restart Apache.

8 If you are upgrading to OES 2:
You might receive the following message when starting Apache 2:
Module "Jk" is not installed, ignoring.

You can safely ignore this message, but if you want to eliminate it:
8a Start YaST, then provide the root password.
8b Click NetWork Services > HTTP Server.

OES 2: /etc/init.d/novell-tomcat5 restart

SLES 10: /etc/init.d/tomcat5 start

OES 2: /etc/init.d/apache2 restart

SLES 10: /etc/init.d/apache2 restart
GroupWise 7 7
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8c On the Server Modules tab, select the jk module in the list of services, then toggle the 
status to Off.

8d Click Finish to save your change.
8e Exit YaST.

You should now be able to run WebAccess and Monitor successfully on your upgraded Linux 
operating system. 

4  GroupWise Client Installation
Section 4.1, “Windows: Installation Instructions,” on page 8
Section 4.2, “Linux: Installation Instructions,” on page 8
Section 4.3, “Macintosh: Installation Instructions,” on page 8
Section 4.4, “GroupWise Connector for Outlook,” on page 8

For detailed installation instructions, see the GroupWise 7 Installation guide 
(GroupWiseInstallationGuide.pdf) in the \docs\us directory on the GroupWise 7 Administrator CD.

4.1  Windows: Installation Instructions
1 Run setup.exe at the root of the GroupWise 7 Client (Windows) CD.

or

Run setup.exe from the client\win32 subdirectory on the GroupWise 7 Client (Windows) CD.
2 Follow the on-screen instructions.

4.2  Linux: Installation Instructions
1 From a terminal window, change to the \linux directory of the GroupWise 7 Client (Linux/

Macintosh) CD.
2 Run the GroupWise Setup Advisor to install the GroupWise Cross-Platform client software:
./install

3 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 
desktop.

4.3  Macintosh: Installation Instructions
1 Browse to the \mac directory of the GroupWise 7 Client (Linux/Macintosh) CD.
2 Double-click the GroupWise.dmg file to install the GroupWise Macintosh* client.
3 To start the Cross-Platform client after installation, click the GroupWise icon on your 

Macintosh desktop.

4.4  GroupWise Connector for Outlook
For instructions on how to install and for additional information about the GroupWise Connector for 
Outlook, see the GroupWise Connector for Outlook Readme. The GroupWise Connector for 
7
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Outlook Readme is available in the \client\doc\us\ directory of the GroupWise 7 Client (Windows) 
CD.

5  Installation Issues
Section 5.1, “General Installation Issues,” on page 9
Section 5.2, “NetWare/Windows Installation Issues,” on page 10
Section 5.3, “Linux Installation Issues,” on page 10

5.1  General Installation Issues
“Version Compatibility” on page 9
“GroupWise 7 Reinstallation” on page 9
“WebAccess and Monitor on the Same Web Server” on page 9
“Web Clipping Application (PQA) Support with WebAccess and Monitor” on page 9
“Additional Installation Issues” on page 10

5.1.1  Version Compatibility

If you install GroupWise on multiple platforms, or if you run multiple versions (for example, 
GroupWise 6.5 and GroupWise 7 in the same GroupWise system), refer to the GroupWise Version 
Compatibility appendix in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7) to make sure that the combinations you are using are supported. For example, 
you cannot run a GroupWise 7 client against a GroupWise 6.5 or earlier post office. Earlier POAs 
cannot support later GroupWise clients. However, you can run a GroupWise 6.5 or earlier client 
against a GroupWise 7 POA.

5.1.2  GroupWise 7 Reinstallation

If you install GroupWise 7 components from a software distribution directory located on your local 
drive or a network drive and then try to update those components by installing from a CD, the 
installation fails by erroneously prompting for a disk:

Please insert the disk: 1

Uninstall the existing software, then install from the CD.

5.1.3  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a common 
library. If you are updating from an earlier GroupWise version and if you run these applications on 
the same Web server, you must update all three before any of them can work properly.

5.1.4  Web Clipping Application (PQA) Support with WebAccess and Monitor

Palm OS* devices are no longer supported in GroupWise 7. However, the Installation program still 
offers the opportunity to configure this feature. If you have been using a PQA in an earlier version of 
GroupWise, you can continue to do so, but it is no longer a supported feature.
GroupWise 7 9
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5.1.5  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

5.2  NetWare/Windows Installation Issues
“Software Distribution Directory Dependency” on page 10
“Problem Installing from a Windows XP Service Pack 2 Machine” on page 10
“GroupWise Version Compatibility” on page 10

5.2.1  Software Distribution Directory Dependency

When you create a new system and are prompted for software to copy to the software distribution 
directory, select at least the agent and client software. The GroupWise Installation program launches 
the Agent Installation program and the Client Installation program. It currently must run those 
programs from the software distribution directory.

5.2.2  Problem Installing from a Windows XP Service Pack 2 Machine

When installing any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet Agent, 
WebAccess Agent, Monitor Agent) to a NetWare server from a Windows XP machine where 
Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later installed on 
the Windows machine. If you have an earlier Novell Client, the GroupWise Installation program 
claims that it cannot find some of the directories to which you want to install software.

5.2.3  GroupWise Version Compatibility

If you still have GroupWise 4.1 domains or post offices in your GroupWise system, you must update 
them to at least GroupWise 5.2 before updating your primary domain to GroupWise 7. If you try to 
update a 4.1 domain or post office to 7 after the primary domain has already been updated to 7, you 
need to rebuild each 4.1 secondary domain database using the GroupWise 7 or later snap-ins to 
ConsoleOne, and you also need to have each rebuilt secondary domain database manually edited by 
Novell Support before it can function correctly with the 7 primary domain. 

5.3  Linux Installation Issues
“Configuring a GroupWise 6.5 Upgrade Installation” on page 10
“Upgrading from an Incomplete Software Distribution Directory” on page 11
“Moving a GroupWise 4.1 System from NetWare or Windows to Linux” on page 11

5.3.1  Configuring a GroupWise 6.5 Upgrade Installation

When you upgrade any GroupWise component to GroupWise 7, all GroupWise components on a 
server must be updated at the same time. A message prompts you to update all components. 
However, you must still run the Configure option for each component so that the software that was 
automatically installed is also configured. If you do not run Configure, the new GroupWise High 
Availability service is not properly configured for the agents.
7
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5.3.2  Upgrading from an Incomplete Software Distribution Directory

Because all GroupWise components on a server must be updated at the same time, if you are 
installing GroupWise 7 from a software distribution directory that does not contain RPMs for all the 
components installed on the server, you receive the following error:

Install failed for an unknown reason (7)

The GroupWise 7 component cannot be updated because its RPM is not present in the software 
distribution directory. You can use the GroupWise 7 Administrator (Linux) CD to update the server, 
then use Configure Administration to create a complete software distribution directory.

5.3.3  Moving a GroupWise 4.1 System from NetWare or Windows to Linux

The Update section of the GroupWise 7 Installation Guide provides instructions for moving from 
NetWare or Windows to Linux. If you are moving post offices and domains belonging to a 
GroupWise 4.1 system, you might need to manually rename the domain database (wpdomain.db) 
from uppercase to lowercase, along with all .dc files. In addition, subdirectories in post office and 
domain directories might need to be renamed to lowercase.

6  Administration Issues
Section 6.1, “General Administration Issues,” on page 11
Section 6.2, “NetWare/Windows Administration Issues,” on page 12
Section 6.3, “Linux Administration Issues,” on page 13

6.1  General Administration Issues
“Images in Global Signatures” on page 11
“Global Signatures and Flat Forwarding through the Internet Agent” on page 11
“ConsoleOne Snap-In Version Compatibility” on page 12
“Server Names” on page 12
“Identity Manager Version Compatibility” on page 12
“Server-Based Anti-Virus Software” on page 12

6.1.1  Images in Global Signatures

You might encounter a problem including an image file in a global signature if the path to the image 
is too long. This is a Java* problem. The easiest workaround is to move the image to a location with 
a shorter path. Another solution on Windows is to set the TMP environment variable to c:\temp 
before starting ConsoleOne.

6.1.2  Global Signatures and Flat Forwarding through the Internet Agent

If you enable global signatures, it disables flat forwarding through the Internet Agent because the 
signature is appended to each message. As an administrator, you must choose which is more 
important in your GroupWise system, global signatures or flat forwarding.
GroupWise 7 11
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6.1.3  ConsoleOne Snap-In Version Compatibility

After a domain has been updated to GroupWise 7, do not administer that domain with earlier 
versions of the GroupWise snap-ins to ConsoleOne. Doing so could result in the unintentional 
creation of duplicate e-mail IDs. 

The e-mail ID indexing scheme has been changed to allow the same e-mail ID to be used in different 
Internet domains within the same GroupWise system. This was prevented by the previous indexing 
scheme. Because the check for uniqueness works differently now, you must use the GroupWise 7 
version of the ConsoleOne snap-ins when administering a GroupWise 7 domain to prevent the 
possibility of duplication.

6.1.4  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot use 
an IP address or DNS hostname.

6.1.5  Identity Manager Version Compatibility

Do not run an existing DirXML® or Identity Manager driver dated earlier than July, 2005, against a 
GroupWise 7 system.

GroupWise 7 requires the latest version of the GroupWise Identity Manager driver. Older drivers are 
not compatible. You can download the required version of the GroupWise driver from the Novell 
Identity Manager Patches Web site (http://support.novell.com/filefinder/20560/index.html).

6.1.6  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices where file locking conflicts can 
create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check the 
GroupWise Partner Products page (http://www.novell.com/partnerguide/p100031.html) for 
compatible products.

6.2  NetWare/Windows Administration Issues
“Directory Names and Filenames” on page 12
“ConsoleOne on Windows NT” on page 13
“GWTSA and Duplicate Source Directories” on page 13
“Utility Startup Switches” on page 13
“Quotas on NSS Volumes” on page 13
“TurboFat Compatibility” on page 13

6.2.1  Directory Names and Filenames

All directory names in paths to GroupWise domains and post offices can consist of up to 8 
characters. 

Filenames can also consist of up to 8 characters, with extensions of up to 3 characters. Do not use 
long filenames for any files used by any GroupWise components. This requirement applies even to 
files that are not specific to GroupWise (such as SSL certificates and key files).
7

http://support.novell.com/filefinder/20560/index.html
http://support.novell.com/filefinder/20560/index.html
http://www.novell.com/partnerguide/p100031.html


novdocx (en)  6 A
pril 2007
6.2.2  ConsoleOne on Windows NT 

If you will run ConsoleOne on Windows NT* 4, you must install NT 4 Service Pack 6 before you 
install ConsoleOne.

6.2.3  GWTSA and Duplicate Source Directories

The GroupWise Target Service Agent (GWTSA) handles situations where the same directory names 
are used on different volumes to back up by numbering the instances. For example:

Original GWTSA 
GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA 
GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2:

Each instance is numbered and DOM is in all uppercase letters. After updating GWTSA with 
GroupWise 6.5 Support Pack 1 or later, you must re-create your backup jobs because the path has 
changed.

6.2.4  Utility Startup Switches

The NetWare version of the GroupWise Time Stamp Utility (GWTMSTMP) currently requires 
startup switches to use a dash (for example, -u), rather than the standard NetWare switch format (for 
example, /u).

6.2.5  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, then you must turn on quotas on all GroupWise 
directories. Otherwise, you will receive No Disk Space errors.

6.2.6  TurboFat Compatibility

If you see E811 errors on the POA or the GroupWise client, a possible cause is that TurboFat is 
corrupting GroupWise database pointers. The solution is to turn off TurboFat.

To turn off TurboFat on NetWare 5.x servers, use turbodis.nlm.
To turn off TurboFat on NetWare 6.x servers, use tdis600.nlm.

These NLMTM programs disable TurboFat at startup.

6.3  Linux Administration Issues
“NFS Not Supported” on page 14
“Pathnames and Filenames in Lowercase” on page 14
“Display Problem with ConsoleOne Property Page Tabs” on page 14
“Unavailable Administration Features” on page 14
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6.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS*, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead.

6.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

However, if you update a GroupWise 4.1 system and move it to Linux, you might see uppercase 
letters in database names. This is not a problem. The Database Copy (DBCopy) utility that you use 
to move domains and post office to Linux handles any uppercase/lowercase issues that might arise, 
so you should not manually rename any databases that have been copied to Linux using DBCopy.

6.3.3  Display Problem with ConsoleOne Property Page Tabs

If you run ConsoleOne on SUSE® LINUX 9 with Ximian® Desktop 2 installed, the label text on the 
property tabs does not display. As a workaround, click the tab to select it, then use the Up-arrow and 
Down-arrow keys to display each property page until you reach the one you want.

6.3.4  Unavailable Administration Features

GroupWise 7 administration on Linux does not include the following features that are available in 
GroupWise 7 on NetWare and Windows:

Import/Export utility in ConsoleOne
Document Properties Management feature in ConsoleOne

7  Agent Issues
Section 7.1, “General Agent Issues,” on page 14
Section 7.2, “NetWare/Windows Agent Issues,” on page 14
Section 7.3, “Linux Agent Issues,” on page 15

7.1  General Agent Issues
None.

7.2  NetWare/Windows Agent Issues
“Potential CAP Port Conflict” on page 14

7.2.1  Potential CAP Port Conflict

By default, the POA uses 1026 for its CAP (Calendar Access Protocol) port. On some Windows 
2000 servers, port 1026 is already used by the Windows Task Scheduler or other Windows service. 
If this occurs, configure the POA to use a different CAP port using the /capport switch in the POA 
startup file.
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7.3  Linux Agent Issues
“libXm.so.3 Error” on page 15

7.3.1  libXm.so.3 Error

If you try to start the POA or MTA using the --show switch on a server where The X Window 
System and Open Motif* are not running, you receive the following error:
libXm.so.3: cannot open shared object file
no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent's Web console to monitor the agent from your Web browser.

8  Client Issues
Section 8.1, “Windows Client Issues,” on page 15
Section 8.2, “Cross-Platform Client Issues,” on page 16

8.1  Windows Client Issues
“Can't Set a Primary Archive Computer” on page 15
“Error Messages When You Install GroupWise Windows Client” on page 15
“Windows XP Service Pack 2” on page 16
“Updated JAWS Script Available” on page 16
“Screen Flickers When Scrolling a Message” on page 16
“Can't Switch Modes Using Microsoft Anti-Spyware” on page 16
“Address Books Do Not Display in GroupWise When Installing GroupWise After Outlook 
2003” on page 16
“Notify Alarms Disappear for Appointments” on page 16
“Spyware Detection Software Causes Installation to Not Work” on page 16

8.1.1  Can't Set a Primary Archive Computer

Currently there is no way to set one computer as a primary archive. This can result in multiple 
archives if you use GroupWise on different computers.

8.1.2  Error Messages When You Install GroupWise Windows Client 

If you install the GroupWise Windows client with Outlook XP already installed, an error message 
appears reading, “Either there is no default mail client or the current mail client cannot fulfil the 
messaging request. Please run Microsoft Outlook and set it as the default mail client”. In addition, if 
you open the Address Book, the GroupWise client crashes.

To fix the problem run win32\wms\nt\us\wms.exe from the install directory, then restart the client.
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8.1.3  Windows XP Service Pack 2

Installing Windows XP Service Pack 2 enables the Windows Firewall by default. The default 
Windows Firewall configuration blocks UDP (User Datagram Protocol). GroupWise is dependent 
on UDP for several key features such as listing new messages in your Mailbox, displaying 
notifications, and performing Busy Searches. To reconfigure the Windows Firewall so that it does 
not interfere with GroupWise functionality, follow the instructions in TID 10094089 in the Novell 
Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

8.1.4  Updated JAWS Script Available

Users of the JAWS* screen reader should install the new JAWS script available in GroupWise 7. 
Copy the groupwise.jsb file from the \client\jaws directory of the GroupWise 7 Client (Windows) CD 
to the \jaws510\settings\enu directory on your workstation. This JAWS script includes Section 508 
accessibility defect fixes that have occurred since the script was updated for GroupWise 6.5 Support 
Pack 3.

8.1.5  Screen Flickers When Scrolling a Message

If you use ClearType to smooth the edges of screen fonts and have an LCD display, your screen 
might flicker when scrolling in a text message.

8.1.6  Can't Switch Modes Using Microsoft Anti-Spyware

If you are using Microsoft's Anti-Spyware software, and you try to switch modes, GroupWise does 
not close. You must manually close GroupWise to switch modes. 

8.1.7  Address Books Do Not Display in GroupWise When Installing GroupWise After 
Outlook 2003

The address books do not display in GroupWise if you install GroupWise for the first time after you 
have installed Outlook 2003. To resolve the problem, uninstall Outlook 2003 before you install 
GroupWise for the first time.

8.1.8  Notify Alarms Disappear for Appointments

After your account has been moved from one post office to another, your Notify alarms disappear 
for appointments. To get your Notify alarms back, you need to re-create all the alarms manually. For 
information on setting alarms for appointments, see the help.

8.1.9  Spyware Detection Software Causes Installation to Not Work

If you have spyware detection software installed on your Windows computer, the GroupWise client 
for Windows might not install properly. Disable the spyware detection software before you install 
the GroupWise client for Windows.

8.2  Cross-Platform Client Issues
“Items Forwarded from the GroupWise Connector for Outlook Do Not Open” on page 17
“Running as root in Caching Mode” on page 17
“Mailbox Size Limits Not Recognized” on page 17
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“Bold Not Displaying on Macintosh” on page 17
“Archiving Over the Network” on page 17
“No Progress Bar Displayed When a Database Is Rebuilt” on page 17
“Focus Is in the Wrong Place When Creating a Reply on Macintosh” on page 17
“GWCheck Must Be Run from a Terminal Window on Macintosh” on page 17
“Corrupt Characters in Asian Languages” on page 18

8.2.1  Items Forwarded from the GroupWise Connector for Outlook Do Not Open

If you receive an item that was forwarded from the GroupWise Connector for Outlook, the item does 
not open in the Macintosh version of the Cross-Platform client.

8.2.2  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If pending 
requests from the root session remain when you log in as a regular user, regular user requests get 
backed up behind the root requests, which cannot be processed while you are logged in as a regular 
user. To resolve any problems, run the client as root again so that all messages are synchronized, 
then run as a regular user thereafter to prevent further problems.

8.2.3  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

8.2.4  Bold Not Displaying on Macintosh

If you have installed Microsoft Office or Internet Explorer on your Macintosh, new messages might 
not display as bold in your mailbox. To resolve the problem, disable your user fonts, which are 
typically duplicates of your system fonts, or update to JVM* 1.4.2 Update 1 or later.

8.2.5  Archiving Over the Network

Archiving with the Cross-Platform client can only be done to your local computer hard drive. 

8.2.6  No Progress Bar Displayed When a Database Is Rebuilt

When prompted to rebuild your database, there is no progress indicator displayed during the rebuild 
process.

8.2.7  Focus Is in the Wrong Place When Creating a Reply on Macintosh

When you click Reply on Macintosh, you cannot just type the message. You must move the mouse 
cursor to the message body window of the reply message before you can start typing. 

8.2.8  GWCheck Must Be Run from a Terminal Window on Macintosh

If you try to browse to the GWCheck program and run it by double-clicking the icon, you receive an 
error stating that there is no associated program. You must run GWCheck from a terminal window 
on Macintosh. 
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8.2.9  Corrupt Characters in Asian Languages

If you're using an Asian language for the client and external recipients are seeing corrupt characters 
in their received messages, then compose your message in HTML instead of text.

9  WebAccess Issues
Section 9.1, “General WebAccess Issues,” on page 18
Section 9.2, “NetWare/Windows WebAccess Issues,” on page 21
Section 9.3, “Linux WebAccess Issues,” on page 24

9.1  General WebAccess Issues
“WebAccess 7 Compatibility with Older Versions of WebAccess” on page 18
“WebAccess 7 Compatibility with Virtual Office 1.5 and Earlier” on page 18
“WebAccess Compatibility with Novell exteNd” on page 18
“WebAccess 7 Client on Macintosh” on page 19
“Login Page Reappears after Successful Login” on page 19
“Recommendation for Tomcat Memory Allocation (Heap Size)” on page 19
““Browser Doesn't Support Java” Error in the WebAccess Java Calendar” on page 19
“Preventing Web Server Directory Browsing” on page 20
“Preventing Unauthenticated Template Access” on page 20
“Updates to WebAccess Templates” on page 20
“Document Viewer Agent Cache Compatibility” on page 20
“Document Viewer Agent /template Switch” on page 20

9.1.1  WebAccess 7 Compatibility with Older Versions of WebAccess

If you have more than one WebAccess Agent in your GroupWise system, you do not need to update 
all of them to GroupWise 7 at the same time. The GroupWise 7 WebAccess Application is 
compatible with older versions of the WebAccess Agent. However, users in post offices with a older 
default WebAccess Agent do not have all of the features available to users in post offices with a 
default GroupWise 7 WebAccess Agent. For more information, see Taking Advantage of Some of 
the New GroupWise 7 WebAccess Features While Still Running GroupWise 6.5 (http://
www.novell.com/coolsolutions/feature/15667.html).

9.1.2  WebAccess 7 Compatibility with Virtual Office 1.5 and Earlier

If you access the WebAccess client through Virtual Office 1.5 or earlier, you might see the old 
WebAccess client interface rather than the new one. To resolve this problem, see TID 10098412 in 
the Novell Knowledgebase (http://support.novell.com/search/kb_index.htm).

9.1.3  WebAccess Compatibility with Novell exteNd

Before GroupWise 7, WebAccess stored its default user interface files in the following directory on 
the Web server:
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tomcat_root/webapps/gw/WEB-INF/classes/com/novell/webaccess/templates/frames

In GroupWise 7, the user interface files are stored in the css subdirectory of templates rather than the 
frames subdirectory.

If you have exteNdTM portlets configured to use WebAccess, you must copy some of the exteNd 
template files from the frames directory into the css directory. Refer to the Novell exteNd 
documentation (http://www.novell.com/documentation/extend5/index.html) to determine which 
exteNd template files you should copy to the css directory. Do not copy the entire contents of the 
frames directory into the css directory; this would damage the new GroupWise 7 WebAccess user 
interface.

In addition, modify the WebAccess URL in the exteNd Portal Preferences from:

http://Web_server_address/servlet/webacc

to:

http://Web_server_address/gw/webacc

9.1.4  WebAccess 7 Client on Macintosh

If you use the WebAccess client in the Safari* Web browser on Macintosh, name completion is 
disabled because of lack of support for certain browser capabilities in Safari. Name completion is 
supported in the Mozilla* Firefox* Web browser on Macintosh.

9.1.5  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or the 
Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 Click Application > Security, then deselect the Use Client IP in Securing Sessions option. 
For information about this option, click Help on the Environment page.

3 Click OK to save the change.

9.1.6  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is set 
by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

9.1.7  “Browser Doesn't Support Java” Error in the WebAccess Java Calendar

This error indicates a browser setup issue. You would encounter the same problem on any Web site 
that uses Java in frames. Depending on your browser, check mozilla.org, sun.com, or other browser 
supplier for more information.
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9.1.8  Preventing Web Server Directory Browsing

If your Web server is configured to allow directory browsing, it is possible for a user to access the /
com directory of your Web server and browse downward from there. There is no confidential 
information located in any of the directories that are accessible in this manner. 

However, if you want to prevent access, you can change the configuration of your Web server. For 
example, if you are using Apache, you can modify the httpd.conf file to remove the access that is 
provided by default. Locate the section that provides directory options for the htdocs directory. 
Either remove the Indexes option from the Options directive or place a minus (-) in front of it. 
Restart Apache to put the change into effect.

9.1.9  Preventing Unauthenticated Template Access

Under certain very specific circumstances, it is possible for a user to view WebAccess template files 
from a Web browser without logging in to WebAccess. There is no confidential information located 
in any of the template files that are accessible in this manner. 

Starting with GroupWise 6.5 Support Pack 4, a line was added to the webacc.cfg file to prevent such 
access:

Templates.requireAuthentication=true

With this setting, unauthenticated users have no access to any WebAccess template files except for 
the Login page. If you have customized WebAccess templates for your own specialized use, this 
setting causes your templates to be inaccessible, even if GroupWise authentication was not 
previously required. You can turn off the authentication requirement by changing the line in the 
webacc.cfg file to:

Templates.requireAuthentication=false

9.1.10  Updates to WebAccess Templates

If you have created your own customized versions of the WebAccess send.inc and msgitem.htt 
templates, you need to make the following changes to these files in order for them to be compatible 
with GroupWise 7:

Do not use the Url.Item.Reply.to and Url.Item.Reply.cc variables to pass and post names in a 
reply message's To and CC fields. Instead, use Item.toFullID and Item.ccFullID (or 
Item.toName or Item.ccName).
When issuing an Item.Read action for a reply, set the Item.Reply parameter to either “sender” 
(to reply only to the sender) or “all” (to reply to all).

9.1.11  Document Viewer Agent Cache Compatibility

The cache created by the Document Viewer Agent is not compatible with the cache previously used 
with WebPublisher. Old WebPublisher cache directories should be removed from servers where the 
Viewer Agent is installed. 

9.1.12  Document Viewer Agent /template Switch

The Document Viewer Agent startup file (gwdva.dva) lists a /template startup switch that is not yet 
implemented.
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9.2  NetWare/Windows WebAccess Issues
“WebAccess Installation Error on Windows Workstation” on page 21
“WebAccess Service Fails to Start on Windows Server” on page 21
“Novell iManager Compatibility on Windows” on page 21
“GroupWise 6.5 Upgrade on NetWare” on page 21
“New NetWare and Windows WebAccess URLs” on page 21
“Web Server File Cleanup Because of URL Change” on page 23
“WebAccess Agent Unload Issue on NetWare” on page 23
“Viewer Agent Issues on NetWare” on page 24
“Security Issue with WebAccess and Internet Explorer 5.0” on page 24

9.2.1  WebAccess Installation Error on Windows Workstation

If you receive an error during installation indicating that the nvweb.dll file cannot be found, update 
the workstation to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.2  WebAccess Service Fails to Start on Windows Server

If you install the WebAccess Agent as a Windows service, reboot the server, and then do a 
workstation login as an Administrator, the WebAccess Agent service might fail to start. If this 
occurs, update to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.3  Novell iManager Compatibility on Windows

If WebAccess and Novell iManager are installed on the same Windows 2000/2003 server, iManager 
might stop working. Because WebAccess installs and configures its own Tomcat and Jakarta 
connector, it is preferable to install it on a server where Tomcat is not already in use.

9.2.4  GroupWise 6.5 Upgrade on NetWare

If the GroupWise 6.5 WebAccess Application is running on the server where you plan to install 
GroupWise 7 WebAccess, you should manually stop WebAccess, the Web server, and Tomcat before 
starting the GroupWise 7 installation. Under certain circumstances, the WebAccess Installation 
program cannot stop them for you.

9.2.5  New NetWare and Windows WebAccess URLs

Existing users of WebAccess are accustomed to accessing the following URLs on NetWare and 
Windows Web servers:

Web Services page: 
Default index.html file of the Web server

WebAccess: 
 http://web_server_address/servlet/webacc
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WebPublisher:  
http://web_server_address/servlet/webpub

The WebAccess URLs on NetWare and Windows Web servers are now the same as the URLs used 
on Linux:

GroupWise-specific Web Services page: 
http://web_server_address/gw/index.html

WebAccess: 
 http://web_server_address/gw/webacc

WebPublisher:  
http://web_server_address/gw/webpub

To keep users' browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions below for your Web server.

Apache

1 Change to the conf subdirectory of the Apache root directory (for example, \apache2\conf.
2 Edit the Apache configuration file for GroupWise.

On NetWare 6, the Apache configuration file is gwapache.conf. On NetWare 6.5, the Apache 
configuration file is gwapache2.conf.

3 Add the following line:
redirect permanent /servlet/webacc http://web_server_address/gw/webacc 

4 If you use WebPublisher, add the following additional line:
redirect permanent /servlet/webpub http://web_server_address/gw/webpub 

5 Save the file, then exit the editor.
6 Restart Apache to put the redirections into effect.

Internet Information Server (IIS)

1 Change to the inetpub\wwwroot subdirectory of the IIS root directory (for example, 
c:\inetpub\wwwroot

2 Create a subdirectory named servlet.
3 Under the servlet subdirectory, create subdirectory named webacc.
4 If you use WebPublisher, create a second subdirectory named webpub.
5 In IIS Manager, expand the tree in the left pane to display Default Web Site under Web Sites.

Under Default Web Sites, you should see the servlet subdirectory you created in Step 2.
6 Expand the servlet subdirectory to display the webacc subdirectory (and optionally, the webpub 

subdirectory) that you created in Step 3.
7 Right-click the webacc subdirectory, then click Properties.
8 Click Directory, select A Redirection to a URL, then type /gw/webacc in the associated field.
9 Select A Permanent Redirection for This Resource, then click OK to save your changes.

10 If you use WebPublisher, repeat Step 7 through Step 9, using webpub in place of webacc.
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11 Restart the IIS Web server to put the redirections into effect.

Netscape Enterprise Server for NetWare

For redirection instructions, search the Novell Support Web site (http://support.novell.com).

9.2.6  Web Server File Cleanup Because of URL Change

As part of the change from /servlet/webacc to /gw/webacc, the WebAccess Installation program 
installs the WebAccess Application files into the servlet container (gw) but it does not remove old 
servlet and htdoc files located under the ROOT container of the servlet and the Web server. 
Therefore, you might want to manually delete the following directories and files:
sys:\apache2\htdocs\com
sys:\apache2\htdocs\index.html (if customized for GroupWise)
sys:\apache2\htdocs\novell.html (if index.html was not customized)
sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapfilt.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapjdk.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njgwap.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njweb.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\SpellServlet.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\web.xml

The one file you should definitely delete is web.xml, because might cause the WebAccess, 
WebPublisher, and Monitor Applications to run in both the old and new locations. Also, if you have 
customized the GroupWise template files, you should copy the contents of the template 
subdirectories under:

sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com\novell

to the corresponding templates subdirectories under:

sys:\tomcat\4\webapps\gw\WEB-INF\classes\com\novell

9.2.7  WebAccess Agent Unload Issue on NetWare

Under certain circumstances, stopping the WebAccess Agent by unloading it at the NetWare server 
command line:

unload gwinter

might cause the following error:

"Module GWDVA.NLM in Address Space GWDVAWRKRX did not unload yet.[lnbrk] Killing the 
address space is the only way to remove the module. [lnbrk]Should the address space be Killed ? n"

Regardless of whether you respond with “n” or “y”, the server might hang and need to be restarted. 
If you encounter this problem on your NetWare server, use one of the following methods to stop the 
WebAccess Agent, rather than using the unload command.

At the WebAccess Agent server console, press F7 or Esc, then select Yes to stop the 
WebAccess Agent.
At the NetWare server console, enter stopweb to stop the WebAccess Agent.
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9.2.8  Viewer Agent Issues on NetWare

On NetWare, the Viewer Agent requires at least 1 GB of memory for running about 5 worker 
processes. By default, 5 processes are started.
On NetWare, you must install the latest Support Pack for your version of NetWare in order to 
have the correct version of clib.nlm.
On NetWare, Memory Protection Fault Cleanup must be set to On in order for the Viewer 
Agent worker processes to recover successfully when a document fails HTML conversion.
On NetWare, when a document fails HTML conversion and its worker process dies, NetWare 
creates a small file named core*.dmp in the server's root directory. You should periodically 
delete these files.

9.2.9  Security Issue with WebAccess and Internet Explorer 5.0

When using Internet Explorer 5.0 to view messages through WebAccess, URLs to messages become 
part of the History cache and can be read by other users who have access to the same workstation. 
For solutions to this problem, see TID 10056452 in the Novell Knowledgebase (http://
support.novell.com/search/kb_index.htm).

9.3  Linux WebAccess Issues
“Novell Distribution of Apache and Tomcat” on page 24
“Prolonged “Please Wait” Message during Installation” on page 25
“Installation Security” on page 25
“Re-installation Issue” on page 25
“Clustering Issue on Open Enterprise Server Linux” on page 26
“Viewer Agent Issues on Linux” on page 26
“WebPublisher Configuration” on page 26
“WebPublisher Template Settings Not Saved” on page 26
“Commented Lines in Configuration Files” on page 26

9.3.1  Novell Distribution of Apache and Tomcat

GroupWise 7 on Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution is installed in the following directories:

Apache:  
/var/opt/novell/http and /etc/opt/novell/http

Tomcat: 
/var/opt/novell/tomcat4 and /etc/opt/novell/tomcat4

and is started using the following customized commands:

Tomcat: 
 /etc/init.d/novell-tomcat4 start
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Apache:  
/etc/init.d/novell-httpd start

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat if 
you want to install the Novell distribution. Select Install WebAccess Application if you do not want 
to install the Novell distribution of Apache and Tomcat because you have an existing Apache and 
Tomcat installation that you want to use with WebAccess.

NOTE: If you are installing on Novell Open Enterprise Server (OES), the option to install with 
Apache and Tomcat is not available.

If you install the Novell distribution on a server where a standard distribution of Apache and Tomcat 
is already installed and running, you will encounter a port conflict on port 80. You can resolve the 
port conflict by choosing to run one distribution or the other, or you can reconfigure one distribution 
or the other.

To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in the /
etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

9.3.2  Prolonged “Please Wait” Message during Installation

On slower machines, if you select Install WebAccess Application with Apache and Tomcat, your 
machine might appear to hang on the “Please Wait” message. Apache and Tomcat are being installed 
while the “Please Wait” message is displayed, before the WebAccess Application installation 
begins.

9.3.3  Installation Security

During installation, the WebAccess Installation program requires access to eDirectoryTM by way of 
LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server's Trusted Root Certificate, which must be exported from the LDAP server, in order for 
LDAP authentication to take place (typically on port 636) during installation of the WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of WebAccess. After disabling the option, restart 
eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.

9.3.4  Re-installation Issue

If you install WebAccess in an eDirectory context where the WebAccess objects already exist, a 
message informs you that you can “use the existing objects.” In actuality, the objects are deleted and 
re-created, so if you have customized the properties of the existing objects, you must customize the 
objects again after installing WebAccess on Linux. 
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9.3.5  Clustering Issue on Open Enterprise Server Linux

The WebAccess Agent currently does not run on Novell Cluster ServicesTM on Linux.

9.3.6  Viewer Agent Issues on Linux

On Linux, if you run the Viewer Agent as a user that is not running The X Window system, 
then WebAccess client users cannot view embedded vector-based graphics in attachments. To 
enable users to view embedded vector-based graphics, make sure that the user that starts 
WebAccess (and hence, the Viewer Agent) is running The X Window System and has a 
DISPLAY environment variable set so that the Viewer Agent can write to the local display. One 
way to accomplish this is to use the sux command to become root before you start the 
WebAccess Agent.
On Linux, the third-party viewer software used by the Viewer Agent has a dependency on 
libXm.so.1, which might not be included with your Linux package. To resolve this, create a 
symbolic link in the agents lib directory to the version of the libXm modules that is available on 
your Linux server. For example:
ln -s /usr/X11R6/lib/libXm.so.3.0.1 /opt/novell/groupwise/agents/lib/libXm.so.1

9.3.7  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 7 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

9.3.8  WebPublisher Template Settings Not Saved

Changes to the settings on the Templates page of the GroupWiseWebPublisher object in 
ConsoleOne are not saved to the webpub.cfg file. To work around this, after making changes on the 
Templates page, select a different property page on the GroupWiseWebPublisher object, then click 
OK or Apply to save the template settings correctly.

9.3.9  Commented Lines in Configuration Files

If you have commented out any lines in the Linux WebAccess configuration file (webacc.cfg) or the 
WebPublisher configuration file (webpub.cfg), you should back up those files before installing 
GroupWise 7. If you use the Configure WebAccess Application option in the Installation program, 
those commented lines become uncommented and the settings return to their defaults. However, any 
other changes you have made to the configuration files are retained. You must comment out the lines 
again and edit the settings as needed, using the backup copies for reference.

10  Internet Agent Issues
Section 10.1, “General Internet Agent Issues,” on page 26
Section 10.2, “NetWare/Windows Internet Agent Issues,” on page 27
Section 10.3, “Linux Internet Agent Issues,” on page 27

10.1  General Internet Agent Issues
“Address Resolution Change Since GroupWise 6” on page 27
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10.1.1  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for sending 
to distribution lists and resources if you set Internet Addressing to one of the following formats 
(which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain
last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the Internet 
Agent. The Internet Agent then successfully resolved the addresses and sent the messages back into 
the GroupWise system. Users did not notice the problem, but some administrators noticed 
unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format for 
distribution lists and resources in their Frequent Contacts address books. If you are updating from 
GroupWise 6 to GroupWise 7 and unnecessary traffic through the Internet Agent is a continuing 
problem, have users delete distribution lists and resources from their Frequent Contacts address 
books so that the correct address format is used for name completion in the future.

10.2  NetWare/Windows Internet Agent Issues
“Internet Agent / WebAccess Agent on the Same Server” on page 27

10.2.1  Internet Agent / WebAccess Agent on the Same Server

If you run the NetWare Internet Agent on the same server and in the same address space with the 
NetWare WebAccess Agent, and if you unload and then reload the Internet Agent, the server abends.

To work around this problem, unload both agents, then reload both agents, or run each agent in its 
own separate address space.

10.3  Linux Internet Agent Issues
“Obsolete grpwise-ia Script” on page 27
“Installation Security” on page 27
“libXm.so.3 Error” on page 28

10.3.1  Obsolete grpwise-ia Script

GroupWise 6.5 included the /etc/init.d/grpwise-ia script for starting and stopping the Internet Agent. 
In GroupWise 7, the Internet Agent is started along with the POA and the MTA, using the grpwise 
script. Therefore, you should delete the obsolete grpwise-ia script from /etc/init.d so that it is not 
used by accident.

10.3.2  Installation Security

During installation, the Internet Agent Installation program requires access to eDirectory by way of 
LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
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LDAP server's Trusted Root Certificate, which must be exported from the LDAP server, in order for 
LDAP authentication to take place (typically on port 636) during installation of the Internet Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of the Internet Agent. After disabling the option, 
restart eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with 
Password and restart eDirectory again.

10.3.3  libXm.so.3 Error

If you try to start the Internet Agent using the --show switch on a server where The X Window 
System and Open Motif are not running, you receive the following error:
libXm.so.3: cannot open shared object file
no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

11  Monitor Issues
Section 11.1, “General Monitor Issues,” on page 28
Section 11.2, “Windows Monitor Issues,” on page 28
Section 11.3, “Linux Monitor Issues,” on page 29

11.1  General Monitor Issues
“Restoring Monitor Settings after Reinstallation” on page 28

11.1.1  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. Agent 
groups are also stored in this file. If you reinstall the Monitor software, the monitor.xml file is 
backed up as monitor.001. To restore previous Monitor settings and agent groups, remove the newly 
installed monitor.xml file and rename monitor.001 to monitor.xml.

11.2  Windows Monitor Issues
“New NetWare and Windows Monitor URLs” on page 28

11.2.1  New NetWare and Windows Monitor URLs

If you've used Monitor on a NetWare or Windows Web server, you are accustomed to accessing the 
following URLs:

Web Services page: 
 Default index.html file of Web server

Monitor Web Console:  
http://web_server_address/servlet/gwmonitor
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Starting in GroupWise 7, use the following URLs on NetWare and Windows Web servers:

GroupWise-specific Web Services page: 
 http://web_server_address/gw/index.html

Monitor Web Console:  
http://web_server_address/gw/gwmonitor

To keep users' browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions in New NetWare and Windows WebAccess URLs, substituting /gw/
gwmonitor for /gw/webacc as needed in the instructions.

11.3  Linux Monitor Issues
“Monitor Issues Shared with WebAccess” on page 29

11.3.1  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues also pertain to Monitor:

Novell Distribution of Apache and Tomcat
Prolonged “Please Wait” Message during Installation
Installation Security
Re-installation Issue

12  GroupWise Connector for Microsoft Outlook 
Issues
For installation instructions and known issues relating to the GroupWise Connector for Microsoft 
Outlook, see the readmeolus.txt file in the \client\docs\us directory of the GroupWise 7 Client 
(Windows) CD.

13  International Issues
Section 13.1, “General International Issues,” on page 29
Section 13.2, “NetWare/Windows International Issues,” on page 30
Section 13.3, “Linux International Issues,” on page 31

13.1  General International Issues
“Double-Byte Characters in Directory Names and Filenames” on page 30
“Double-Byte Characters in Passwords” on page 30
“Euro Character in the Subject Field” on page 30
“Character Encoding in WebAccess” on page 30
“WebAccess Spell Checker Displays Corrupt Characters for Russian” on page 30
“Monitor Web Console Display in German and Other Languages” on page 30
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13.1.1  Double-Byte Characters in Directory Names and Filenames

Do not use double-byte characters in directory names and filenames.

13.1.2  Double-Byte Characters in Passwords

Do not use double-byte character in users' passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-byte 
characters. However, the GroupWise client login does not allow entry of double-byte characters in 
passwords, so a user who was assigned a password with double-byte characters in ConsoleOne 
cannot type the double-byte characters when attempting to log in to GroupWise.

13.1.3  Euro Character in the Subject Field

If a WebAccess client user receives a message, task, or appointment with a Euro character in the 
Subject field, it might display as an upside-down question mark when viewed in the Java version of 
the Calendar. The issue resides with the user's browser.

Netscape users need to upgrade to Netscape Communicator* 6.

Internet Explorer users should be using at least version 3309 of the JVM. The latest JVM can be 
downloaded from the Microsoft Web site and installed on the user's workstation. This JVM enables 
Internet Explorer 4.x and later to correctly display the Euro character.

13.1.4  Character Encoding in WebAccess

Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does not 
work for some Web browsers. If you do not see the localized languages in the drop-down menu on 
the Web services page (index.html), set your Web browser's character encoding to UTF-8. In some 
browsers, you can click View > Encoding to set the Web browser's encoding.

You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your Web browser's character encoding for the new message window to UTF-8. You 
can do this by right-clicking in the new message window and then setting the encoding, or by 
clicking View > Encoding.

13.1.5  WebAccess Spell Checker Displays Corrupt Characters for Russian

When Russian characters are used, they are displaying in the Spell Checker as corrupt characters.

13.1.6  Monitor Web Console Display in German and Other Languages

On the Monitor Web console, you might see incorrect display of some characters, particularly 
accented characters.

13.2  NetWare/Windows International Issues
“Print Calendar Language” on page 31
“RichWin and GroupWise 7” on page 31
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13.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.

13.2.2  RichWin and GroupWise 7

If you use RichWin in combination with GroupWise 7, be sure to run RichWin first, then run 
GroupWise.

13.3  Linux International Issues
“Display Problem with Agent Console Interfaces” on page 31
“Russian Keyboard” on page 31
“Mnemonics for Arabic, Hebrew, and Double-Byte Languages” on page 32
“Localized Agent User Interface Display” on page 32
“Right-to-Left Text in Cross-Platform Client Help” on page 32

13.3.1  Display Problem with Agent Console Interfaces

If you run the agents with an agent console interface in languages other than English, the display of 
logging information might not display correctly. The problem occurs if your language encoding is 
set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:

locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.
2 Select the language you are running the agents in, then click Details.
3 Deselect Use UTF-8 Encoding, then click OK.
4 Stop and then restart the agents to put the new setting into effect.

13.3.2  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be set 
explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform client. 
Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables and 
resolves all Russian keyboard problems. If you set the LANG environment variable and your 
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Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

13.3.3  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

13.3.4  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

13.3.5  Right-to-Left Text in Cross-Platform Client Help

Languages that display right-to-left display right-justified rather than left-justified.

14  Documentation Issues
Section 14.1, “General Documentation Issues,” on page 32
Section 14.2, “NetWare/Windows Documentation Issues,” on page 32
Section 14.3, “Linux Documentation Issues,” on page 33

14.1  General Documentation Issues
None.

14.2  NetWare/Windows Documentation Issues
“GroupWise Windows Client Help” on page 32

14.2.1  GroupWise Windows Client Help

To support accessibility requirements within GroupWise Help, the Help for the GroupWise 
Windows client uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.
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14.3  Linux Documentation Issues
“Agent Help Does Not Display When Agent Runs as a Non-root User” on page 33
“Help Image Display on an iChain Server” on page 33

14.3.1  Agent Help Does Not Display When Agent Runs as a Non-root User

When you start the POA, the MTA, and the Internet Agent using the --show switch to display a GUI 
user interface, if the agents are running as a non-root user, clicking Help does not display the agent 
help file. Help is displayed in a browser window and the agents currently launch the browser as root. 
Giving the user access to the browser window as root would be a security risk.This is working as 
designed.

14.3.2  Help Image Display on an iChain Server

If you display help from an agent Web console on a server where Novell iChain® is installed, and if 
iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

15  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark.

16  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion 
lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not 
use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please 
refer to www.novell.com/info/exports/ for more information on exporting Novell software. Novell 
assumes no responsibility for your failure to obtain any necessary export approvals.

Copyright © 2005 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.
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Novell, Inc. has intellectual property rights relating to technology embodied in the product that is 
described in this document. In particular, and without limitation, these intellectual property rights 
may include one or more of the U.S. patents listed at http://www.novell.com/company/legal/patents/ 
and one or more additional patents or pending patent applications in the U.S. and in other countries.

ConsoleOne, DirXML, GroupWise, iChain, NetWare, Novell, and Ximian are registered trademarks 
of Novell, Inc. in the United States and other countries.

SUSE is a registered trademark of SUSE AG, a Novell business.

eDirectory, Evolution, exteNd, NLM, Novell Client, and Novell Cluster Services are trademarks of 
Novell, Inc.

All third-party trademarks are the property of their respective owners.
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